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About this document 
This document describes the System Design process. A working knowledge of System Builder (SB) and Dynalite 
commissioning processes is required to effectively use this document. 

Target audience 
System Designers, Specifiers and Commissioning Engineers 

Prerequisites 
Before designing a system, you should have completed System Builder training modules 1 and 2. 

Disclaimer 
These instructions have been prepared by Philips Dynalite and provide information on products for use by 
registered partners or owners. Some information may become superseded through changes to the law and as a 
result of evolving technology and industry practices. Any reference to non- Philips products or web links does not 
constitute an endorsement of those products or service. 

The approach in this guide will be generic in nature. However, depending on the geographic location of the 
building, there will be national, regional, and local electrical and occupancy regulations that will need to be 
considered in the planning and implementation and installation of the system. 

Copyright 
© 2020 Signify Holding. All rights reserved. Specifications are subject to change without notice. No representation 
or warranty as to the accuracy or completeness of the information included herein is given and any liability for 
any action in reliance thereon is disclaimed. Philips and the Philips Shield Emblem are registered trademarks of 
Koninklijke Philips N.V. All other trademarks are owned by Signify Holding or their respective owners. 
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1 Enable Design Mode 
1.1 Overview 

System Designer (SD) streamlines the process for generating control system designs.  

Responding to a quotation request is an important step in the sales process, enabling the specifier to make an 
informed purchasing decision and providing an opportunity to win their business. Producing the lighting system 
design involves examining the floor plans, counting lamps, fixtures, circuits, and devices, calculating circuit loads 
and identifying the cable runs, then pricing the hardware, installation work and commissioning services. System 
Designer saves you time by automating many of these tasks. 

System Designer lets you load vector drawings of floor plans and define the shape of items from the floor plan 
legend. The shape recognition tool automatically scans each floor plan and identifies fixtures and devices. 
System Designer keeps count of all items and provides a load schedule and hardware summary as well as 
offering several reports for different stakeholders. 

Additionally, System Designer completes the initial commissioning steps while you are quoting without any 
additional work. This delivers a head start in commissioning, significantly reducing the time to put a system into 
operation. System Designer helps to:  

• Define the project requirements. 

• Import multiple floor plans. 

• Identify the location of light fixtures, sensors, user interfaces and distribution boards. 

• Identify the number and types of circuits. 

• Count the lamp types, fixtures, sensors, and user interfaces. 

• Calculate loads per circuit. 

• Estimate the number and type of control devices required. 

• Calculate control network loads and supply requirements.  

• Build the job in the commissioning software as you produce your quote. 

• Provide an electronic record of the quote. 

• Publish various reports from the quote information for different stakeholders. 

• Rescan and modify the quote for floor plan revisions, saving rework. 

A special license is required to enable Design Mode, The license can be requested by emailing 
support.controls@signify.com 

 

mailto:support.controls@signify.com
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1.2 Design Summary 

The Design Summary window enables you to visualize and track the progress of your quote. The design summary 
is shown in the lower part of the Physical View window. The design summary shows a count of the: 

• Total number of circuits on the floor plan 

• Total number of universes on the floor plan 

• Total number of fixtures on the floor plan and how many have been grouped into circuits or universes, 

• Total number of devices on the floor plan 

• Percentage of commissioned fixtures and devices. 

The design summary provides shortcuts to help you navigate on the floor plan. Clicking an object in the Design 
Summary window selects every occurrence of that object on the floor plan. 

When not in Design Mode, the Design Summary can be used for tracking the commissioning progress. 
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1.3 Design Assistant 

System Designer provides a Design Assistant to walk you through the steps of producing an accurate quote 
without resorting to pen and paper. The Design Assistant provides a step by step procedure for constructing a 
quote, including hyperlinks to the required tools. 

To open the Quote Assistant, from the View menu, select  Design Assistant. Design Mode is automatically 
enabled when viewing the Quote Assistant. 

The recommended process for producing a quote is as follows: 

1. Enable Design Mode 
2. Select Voltage 
3. Manage Revisions 
4. Load Plans 
5. Define Scale 
6. Define Perimeter 
7. Add Distribution Boards 
8. Set up Fixtures 
9. Place Fixtures 
10. Group Fixtures 
11. Place Devices 
12. Draw Areas 
13. Add DyNet Cable 
14. Renumber Circuits and Devices 
15. Select Hardware 
16. Generate Reports 
17. Produce Documentation 
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1.4 Starting a design 

Enabling Design Mode changes the view in the floor plan window to help you identify items in your quote.  
This includes highlighting fixtures, displaying thicker cable lines, and showing callouts for circuits and universes. 

To start a quote, click  Design Mode on the floorplan toolbar. The Design Mode icon displays on the floorplan 
heading with the plan name in bold and the floor plan toolbar now displays the quote tools.  

 

 

 

Design tools 

 Design Mode 

 Manage Revisions 

 Import plans from background images (Load Plans) 

 Open Shape Recognition Editor (SRE) 

 Open Quick Fixture Setup 

 DALI Universe Profile Editor 

 Show Hardware Selector 
 
Drawing tools 

 Draw Area Region 

 Draw Line 

 Create Text 

 Draw Perimeter Wall 

 Set Background Scale Factor 

Job Tools 

 Design Assistant (Alt+9) 

 Job Notes 

 Toggle Design Mode On and Off 
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2 Select Voltage 
Depending on your country you can select one of the following supply voltages or enter your own value.  
This is stored as a job property and is used to calculate the current for each circuit. 

• 110 VAC 

• 240 VAC 

• 277 VAC 

Without the Design Assistant you can select the Voltage in Tools > Settings > Job settings > Job File> Voltage (V) 

D You can still enter different voltages for individual circuits if required. 

 

You can also select the load controller supply voltage if it is different to the circuit voltage. 

• 110 VAC 

• 240 VAC 

 

The last option allows you to select the voltage for the RS-485 DyNet cable. This based on the devices available 
in your region. 

• 12 VDC 

• 24 VDC 

3 Manage Revisions 
The Revision Manager provides a revision history to keep track of updates and variations to your quote. 

If new revisions of floor plans are provided, the floor plan background image can be updated using the Replace 

Background Image feature. For a new revision of a floor plan drawing, click  Replace background image, and 
rerun the shape search. The Shape Recognition Editor will update the placement of fixtures and devices. 

Design revisions can branch off from any of your previous revisions and you can revert to a previous design, if 
required. 
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4 Load plans 
On receipt of the tender documentation, the floor plan drawings may be available as a single or multiple page 
PDF file. System Designer imports all PDF pages as separate floor plan background images. 

 

 

You can add plans by clicking  Import plans from background images or click the File menu and select File > 
Import > Plans from Background Images, then select a PDF file (you can select more than one PDF file).  

The  Background Image tool lets you rotate the image clockwise and counterclockwise to the correct 
orientation if required. 

For a multiple page PDF, you can import a page range or all pages. Clicking OK will import the pages and create a 
new floor plan in physical view for each imported page.  

You can sort the plans into alphabetical order, either ascending or descending, by clicking on the Name heading 
or sort on other property headings once you have entered the information in the Floor Plan Properties Editor. 
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5 Define Scale 
You can set the scale of each floor plan drawing, enabling you to estimate areas sizes and cable lengths.  
There are two methods for setting the plan scale: 

 

• Draw a line and enter the background full-scale line length. 

 

• Enter the background scale factor as stated on the plan. 

 

 

6 Perimeter Wall 
You can draw a perimeter on each floor plan to define 
the boundaries of the floor. This removes unnecessary 
details and speeds up searches. This perimeter wall is 
the Shape Recognition default search area as well as 
the location where circuit callouts are placed. 

You can perform the following actions: 

 Draw Perimeter Wall 

 Edit Perimeter Wall 

 Clear Perimeter Wall 

 

To draw the perimeter wall, click at each corner of the 
plan. Double-click to finish. 
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7 Add Distribution Boards 
The location of a Distribution Board (DB) indicates where the wiring for each 
circuit originates.  

Once you have manually added a DB to Physical view or by entering a 
name in the Callout properties, you should then place each DB on the floor 
plan. 

Hovering the mouse pointer over the DB displays the DB name and the name of devices within the DB. 

 

Add a Distribution Board: 

1. Click  Show Floor Plan to open the floor plan where you want to place the DB. 

2. Click  Add distribution board on the physical view toolbar  
(if it hasn’t already been created from the Callout properties). 

3. Enter the DB name. 

4. Click and drag the DB to place it on the floor plan. 
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8 Set up Fixtures 
The Quick Fixture Setup window allows you to enter all your fixture profiles in a single table. You can do this 
either at the beginning of your quote or later when grouping the placeholder icons on the floor plan.  

 

Quickly setup user-defined fixture profiles (recommended) 

1. Click  Quick Fixture Setup 

2. Click in each in each cell or press F2 to enter the information into the table. 

• Code – Drawing ID 

• Description– Fixture profile description 

• Type– Control type 

• Load (Watts) – channel load in Watts 

• Power Factor – The active power divided by the apparent power. 

• Color– Fixture color 

• Icon– Fixture icon 

3. You can click in the first column to select a row, to  duplicate or  delete that row  

4. Click OK when complete. 

 

 

Alternatively, you can add user defined fixtures profiles using the main Fixture Profile Editor. The Fixture Profiles 
Editor is available in the Properties window when you click the job name in Network View or Physical View. 

 

D It is recommended that while you are building your design, you regularly save the job by clicking  

 File Save. 
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9 Place Fixtures 
There are two ways to place fixture icons on the floor plan: 

• Place fixture icons with the Shape Recognition Editor (SRE) by defining and searching for fixture shapes.  

• Place fixture icons manually by selecting them from the fixture palette and clicking on the floor plan. 

 

9.1 The Shape Recognition Editor 

On the floor plan toolbar, click  Open Shape Recognition Editor (SRE). 

 

 

 

Before searching for shapes, you should review the floor plan drawings to find the legend.  

While it is not always reliable, it is often possible to define shapes using the legend in the PDF. Alternatively, you 
can create a plan page to display the data or printout the legend page as a reference to help you identify which 
shapes to search for. 

The SRE can search a floor plan for your defined shapes and automatically replace each discovered shape with a 
placeholder or with the defined fixture or device. If you do not find all the expected shapes you can redefine a 
shape and repeat the search until all icons are placed on the floor plan. 

On the floor plan drawing, a shape can represent a:  

• Fixture (actual or placeholder) 

• Device (actual or placeholder for ceiling sensor, wall sensor, user interface) 

Place holders are intended to allow the designer to make a note of there being a fixture, sensor, or UI on the plan 
without having to define the specific details of that item at that moment.  

You can change the fixture placeholders to fixture icons later when grouping them into circuits/DALI universes. To 
add fixture profile information, right-click the placeholder on the floor plan and selecting Edit Properties. 

You can change the device placeholders to device icons later by attaching a device to the shape in the SRE and 
searching again or when selecting devices in the Hardware Selector. 

 

E It may be helpful to click  Float Floor Plan Window (Ctrl+F9) and then maximize the floor plan window, 
so you can easily see items on the plan. 
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The shape search feature can find different shapes based on just the shape or the shape with some nearby text.  
It can then replace the identified shape with a placeholder icon or a fixture icon (if a fixture profile is added to the 
shape). 

For example: 

• Shape D2 has nearby text added to the shape definition and a fixture profile attached to the shape.  
The search will identify these shapes if they have this nearby text and replace them with the attached 
fixture icon. 

• Shape S3 has no text added to the shape definition and a fixture profile attached to the shape.  
The search will identify these shapes and replace them with the attached fixture icon. 

• Shape A1 has no text shape added to the shape definition and no fixture profile attached to the shape. 
The search will identify these shapes and replace them with a placeholder. 

 

 

9.2 Defining fixture shapes 

Define a shape: 

1. Click  Add shape to add a new shape to the search list. This can be for a fixture or for a sensor, light 
switch or other 3rd party device. A new undefined shape is added to the list. 

2. Double-click the undefined shape or alternatively, select the Image property on the right and click the 
Select shape button. The floor plan window is displayed. 

3. Click and drag a box around a fixture to select it. The selected shape lines will appear thicker. See 
example below. Alternatively, you can hold down the Ctrl key to add individual lines or the Shift key to 
remove individual lines from the selected shape. 

 

If you have difficulty selecting a line where there are multiple lines, pressing the spacebar will select each 
line in turn. 

4. Press Enter or double-click on white space to complete the shape selection. The Shape Recognition 
Editor reopens showing the defined shape in the legend column. 

 

E If a fixture drawing has hidden lines in another color, you can click and drag a rectangle around each line 
to select it, which will also select any hidden lines. 
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5. Repeat steps 1 to 4 to add each different fixture shape. 

 

 

E If you want to define more than one shape at a time on the 

plan, select  Quick Setup > Select Multiple Shapes from 
Plan. Each shape you define will turn green. Right-click or 
press Ctrl+ Enter to save all shapes and return to the editor. 

E For best performance it is recommended to add as many shapes as possible before searching. 

 

At this stage, performing a search will put a placeholder on the floor plan wherever it finds each defined shape. 
Later, you can select the fixtures to replace each placeholder when grouping them into circuits. This method is 
useful when different fixture types have a similar shape. 

 

E The SRE can find shapes more reliably when they are simpler. If you have different fixture types all with a 
similar shape, then it may be difficult for the SRE to differentiate between them. In this case it is faster to 
define a simple shape and add placeholders during the search. Then you can visually group and select 
the different fixture types on the floor plan.   

 

Alternatively, if you have already created a user defined fixture profiles in the  Quick Fixture Setup window, 
then you can attach a fixture to each shape. The search will then place a fixture icon on the floor plan wherever it 
finds your shape, instead of using a placeholder. 
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Add a fixture to a shape: 

1. Click  Add Fixture with No Text Shape or With Text Shape. A fixture profile entry is added underneath 
the shape. If you selected, No Text Shape proceed to step 3. 

2. If you have selected, With text Shape then double-click  to define the shape of the nearby text for 
your fixture or device. For example 

 

3. Click the Fixture Profile property on the right and click the Change button to select the required fixture 
icon for the shape. 

 

 

4. Add the details in the quick fixture setup window and click OK. 

 

 

5. In the Shape Recognition Editor, click the Save button to save your shape definitions to the job. 
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9.3 Searching for fixture shapes 

After defining your shapes, the Shape Recognition Editor can search a floor plan or part of a floor plan for all the 
shapes in your list. 

 

Search for shapes: 

1. Select the shapes you want to include in the search. You can select multiple shapes by holding the Ctrl 
key. To be discovered, the shape must be an exact match of the same shape, however, it can be a 
different scale or orientation. 

2. From the  Search dropdown list, select one of the following options.  

• Search All Shapes 

• Search Selected Shapes 

• Search All Shapes (within perimeter wall) 

• Search Selected Shapes (within perimeter wall) 

After selecting a search option, the floor plan will open. 

3. If you selected Search All Shapes or Search Selected Shapes, click and drag a rectangle to select the 
region of the floor plan to search (you may need to zoom out). If searching the whole floor plan, exclude 
any tables and text around the margin. 

If you selected a search within the perimeter wall, then the search will automatically start.  

4. When the search is complete it will show the number of: 

• matching fixtures 

• matching devices  

• matching shapes without a fixture or device. 

You are asked “Do you want to create icons and placeholders on 
the plan?” 

Click the Yes button to create the matching fixture, device, or 
placeholder icons on the plan or  
click the No button to leave the floor plan unchanged.  

 

D Placeholders are available for both fixtures and devices. 

D For large floor plans you can change the maximum zoom by selecting Tools > Settings > Job settings > 
floor plan > Max zoom. 

D In the Shape Recognition Editor Legend list, the searched for shape must be aligned to 90 degrees 
(horizontal or vertical) to be located on the floor plan. The shape on the floorplan can have any angle of 
rotation. 

D If some new placeholders are not created it is likely because they would be on top of another 
placeholder or because a placeholder already exists in that location. 

D Locking the canvas stops shape recognition. 

D In the Shape Recognition Editor, click the Save button to save the shape definitions to the job. 
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The Shape Recognition Editor lets you perform the following actions: 

 Add Shape – adds a new undefined shape and allows you to define the shape from an item on 
the floor plan.  

 Add Fixture – attaches a fixture profile to the shape (with or without nearby text).  

 Add Device – attaches a device or placeholder to the shape (with or without nearby text). 

 Duplicate an item – adds a copy of the selected item to the list. 

 Remove an item – deletes an item from the list. 

 Select Shape from Plan – enables you to define a shape from the plan. 

 Rotate Shape Left 

 Rotate Shape Right 

 Rotate Shape to Horizontal 

 Expand All 

 Collapse All 

 Quick Setup – Select Multiple Shapes from Plan. 

 Import shapes – loads shapes from a stx file that was saved from a previous job. 

 Export shapes – saves shapes to a stx file for reuse in another job. 

 Search options – Allows you to add criteria to the search function for scaling, line width or line 
color. 

 Search for shapes – Searches for all shapes or selected shapes on the floorplan. 

 

9.4 Manually placing fixture icons 

Instead of using the Shape Recognition Editor, you can always manually add placeholders or fixtures to the floor 
plan from the fixture palette. However, this is not recommended when there are a high number of fixtures on your 
floor plan drawing.  

Right-click on a fixture icon and select Save Icon Size and Rotation or Copy and Paste fixture icons to reduce the 
time taken to manually place icons. 

 

E The Design Summary in the lower part of the Physical View keeps count of all the fixtures, circuits, and 
devices in your quote. You can easily identify a group of objects on the floor plan by clicking an object in 
the Design Summary. 
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10 Group fixtures 
Select multiple fixtures or draw lines between fixtures to group them into circuits or DALI universes. 

Floor Plan window hot keys (when in pointer mode): 

A = Draw Area 
C = Group fixtures to Circuit line 
D = Group fixtures to DALI line 
N = Group devices to DyNet cable line 
R = Rotate icons 
S = Scale icons 

 

10.1 Circuits and DALI universes 

Fixtures can be grouped into circuits or DALI universes by either: 

1. Selecting one or more fixtures, then from the right click menu selecting Group Fixtures (shortcut key C) or 
Group to DALI universe (shortcut key D). Multiple fixtures can be selected by holding down the Ctrl key or 
by drawing a box around multiple fixtures. 

2. Selecting the  Draw Fixture Group or Draw DALI Cable tool under the Draw line icon on the floor 
plan toolbar and drawing lines between the fixtures.  

 

 

E A DALI cable can be used for DALI broadcast or DALI addressable control. If a DALI cable-line spans 
multiple areas, it will be assumed to be DALI addressable.  

 

in the Design Summary, under Fixtures, select the  Ungrouped icon for a fixture type, to highlight the 
remaining ungrouped fixtures on the floor plan. 
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10.2 Callouts 

Once fixtures have been grouped into a circuit or a DALI universe, then a callout for the circuit or universe will 
appear on the floor plan.  

Enter the Callout Properties and click OK. 

   

 

If you enter a new distribution board name, it will be created in the physical view when you click OK.  
Remember to place the DBs on the floor plan. 

If you enter a new Fixture Profile name and click OK, the Quick Fixture Setup opens to prompt you to fill in the 
details for the new fixture.  

Right-click to scale the Callout or edit the Callout properties. 
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The Callout displays information about the circuit or universe.  

 

E The circuit name is optional and be enabled from the Tools menu under: 
Settings > Job Settings > Floor Plan > Callouts > Show circuit name in callout icon.  

 

Hovering the mouse pointer over the callout displays the callout properties. 

 

 

The load type determines: 

• the dashed line color on the cable. 

• the circuit number background color on the left side of the callout. 

 

Color Load type 

White 
Unset 

Light violet-grey 

DALI 
DSI 
1-10V 

Pale Pink 
DMX 

Very pale red 

Incandescent (no driver) 
LED (LE compatible electronic driver) 
Halogen (LE compatible electronic driver) 

Light Orange 

LED (TE compatible electronic driver) 
Halogen (TE compatible electronic driver) 

Pale azure 

LED (LE/TE compatible electronic driver) 
Halogen (LE/TE compatible electronic driver) 

Light cyan-blue 
LED PWM 

Strong green 

Switched Load 
Motor 

Brilliant green 
Ceiling Fan 

Pale yellow 
Curtains 
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10.3 Select Fixture Profiles 

Right-click the Callout and select Edit Properties to select or enter the fixture 
profile for the group. This is very useful if placeholders were added by the Shape 
Recognition Editor and the cable contains a single type of fixture.  

If the cable contains different types of fixtures then the fixtures profiles can be 
easily set by multi-selecting each placeholder or type of fixture, right-clicking 
and selecting Edit Properties to select the fixture profile.  

New fixture profiles can be created in either the Callout or Fixture properties 
dialog box by simply entering a new name. The fixture profile properties can be 

modified in the Fixture Profile Editor or in the  Quick Fixture Setup window. 

 

10.4 Manage DALI Universes 

The name and color of DALI universes can be changed from the DALI Universe Profile Editor. From the DALI 
Universe callout properties, click the Editor link to open the DALI Universe Profile Editor. The color is displayed on 
the right side of a DALI universe callout. 
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11 Place devices 
11.1 Defining device shapes 

Select each plan to place devices such as gateways, user interfaces and sensors. These can be added 

automatically for PDF floor plans by opening the  Shape Recognition Editor from the floor plan toolbar. 

Define a shape: 

1. Click  Add shape to add a new shape to the search list. This can be for a fixture or for a sensor, light 
switch, or other 3rd party device. A new undefined shape is added to the list. 

2. Double-click the undefined shape or alternatively, select the Image property on the right and click the 
Select shape button. The floor plan window is displayed. 

3. Click and drag a box around a device to select it. The selected shape lines will appear thicker. See 
example below. Alternatively, you can hold down the Ctrl key to add individual lines or the Shift key to 
remove individual lines from the selected shape. 

 

If you have difficulty selecting a line where there are multiple lines, pressing the spacebar will select each 
line in turn. 

4. Press Enter or double click on white space to complete the shape selection. The Shape Recognition 
Editor reopens showing the defined shape in the legend column. 

 

E If a device drawing has hidden lines in another color, you can click and drag a rectangle around each line 
to select it which will also select any hidden lines. 

E By changing the orientation of the shape you can change the orientation of the placed device. 
Right-click the shape to rotate. 
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5. Click  Add Device with No Text Shape or With Text Shape. A Device entry is added underneath the 
shape.  

Or you can select Placeholder > Ceiling Sensor, Wall Sensor, or User Interface. A placeholder entry is 
added underneath the shape. 

If you selected No Text Shape or Placeholder, proceed to step 7. 

6. If you have selected With text Shape, then double-click  to define the shape of the nearby text for 
your fixture or device. For example: 

 

7. Click the Device property on the right and click the Change button to select the device icon or 
placeholder icon. 

 

 

8. Repeat steps 1 to 7 for each different type of device. 

9. Click the Save button to save your shape definitions to the job. 

 

E If you want to define more than one shape at a time on the 

plan, select  Quick Setup > Select Multiple Shapes from 
Plan. Each shape you define will turn green. Right-click or 
press Ctrl+ Enter to save all shapes and return to the editor. 

E For best performance it is recommended to add as many shapes as possible before searching. 
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11.2 Searching for device shapes 

After defining your shapes, the Shape Recognition Editor can search a floor plan or part of a floor plan for all the 
shapes in your list. Make sure you have added a device icon or placeholder icon to a shape before starting the 
search (otherwise the search will not know if the shape is a fixture or a device).  

 

Search for shapes: 

1. Select the shapes you want to include in the search. You can select multiple shapes by holding the Ctrl 
key. To be discovered, the shape must be an exact match of the same shape, however, it can be a 
different scale or orientation. 

5. From the  Search dropdown list, select one of the following options.  

• Search All Shapes 

• Search Selected Shapes 

• Search All Shapes (within perimeter wall) 

• Search Selected Shapes (within perimeter wall) 

After selecting a search option, the floor plan will open. 

6. If you selected Search All Shapes or Search Selected Shapes, click and drag a rectangle to select the 
region of the floor plan to search (you may need to zoom out). If searching the whole floor plan, exclude 
any tables and text around the margin. 

If you selected a search within the perimeter wall, then the search will automatically start.  

7. When the search is complete it will show the number of 
matching devices: 
 
You are asked “Do you want to create icons on the plan?” 

Click the Yes button to create the matching device icons or 
placeholder icons on the plan or click the No button to leave the 
floor plan unchanged.  

 

D The total numbers of each device type can be seen in the summary window in the lower half of the 
physical view. 

 

11.3 Manually placing device icons 

Instead of using the Shape Recognition Editor, you can always manually add devices or placeholders to the floor 
plan from the Device palette. However, this is not recommended when there are a high number of devices on 
your floor plan drawing.  

Additional devices such gateways and other integration devices can also be added manually. 

Right-click on a device icon and select Save Icon Size and Rotation or Copy and Paste fixture icons to reduce the 
time taken to manually place icons. 

 

E The Design Summary in the lower part of the Physical View keeps count of all the fixtures, circuits, 
devices and placeholders in your quote. You can easily select a group of objects on the floor plan by 
clicking an object in the Design Summary. 
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12 Draw Area 
To provide a visual indication of completed quoting tasks on the floor plan, it is recommended to draw an Area 
Region around the completed fixtures and devices. Selected areas are displayed in a paler yellow color. 

 

Draw Area Region: 

1. Select the  Draw Area Region tool (shortcut key A). 

2. Click at each point along the walls of the area to create a shape that fills the room. Double-click to finish.  
The Area Selection dialog box opens. 

3. Enter the Area Name and click the OK button. 

  

 

D When you select an area and click  Job Notes, the floor and area name are automatically inserted into 
the next line as a reference. 

 

13 Add DyNet cable 
Once you have placed your device icons you can draw the DyNet cable between them and the nearest 
distribution board (shortcut key N). DyNet cables can be drawn to connect each Dynalite device in a daisy chain 
arrangement. This determines the order of devices in the single line reports. 

Draw DyNet Cable: 

1. From the Draw Line tool select 

 Draw DyNet Cable. 

2. Click the distribution board to start 
drawing the DyNet line 

3. Click on each device in the run 

4. Return the line to the distribution 
board when complete. 

5. Double-click to stop drawing. 
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On the RS-485 cable, controllers supply current. Sensors and user Interfaces consumer current. The line tooltip 
shows current and device count (total count including devices in the DB). 

 

 

 

C Ensure there is sufficient DyNet current to power the user interfaces and sensors by adding a power 
supply to the DyNet line, if required. Do not exceed the maximum cable current of 2 A.   

 

When drawing a DyNet cable line through a DDNI485 the line is split into two and each part is treated separately 

 

 

The maximum cable length and current can be configured in user settings 
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14 Renumber Circuits and Devices 
Renumbering the circuits and devices sequentially makes reports easier to understand. You have two options: 

• Renumber all starting from 1. This is best for the first revision of a design. 

• Renumber only the circuits and devices that have been added since the last time the renumber function 
was run. This is useful for revisions when you do not want to affect numbers from earlier revisions. 

For example, if an interface is not required, you can delete it and renumber the Device location sequence for the 
remaining devices. 

 

15 Select Hardware 
15.1 Producing a bill of materials 

The Hardware Selector window aids in assigning circuits and universes to compatible load controllers to create a 
bill of materials. When hardware selection is complete, you can export a CSV spreadsheet containing a total list of 
devices for your design.  

Alternatively, you can export a CSV spreadsheet containing a summary of all the circuits and universes in the job. 
This can be used to manually determine the load controllers required in each distribution board. 

Click Show Hardware Selector, or open the  Design Assistant and under Select Hardware,  
click the Open Hardware Selector Window link  

The Hardware Selector has the following three sections: 

• Job Items  

• Available Devices 

• Controller List 
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The controller list has a filter tool where you can filter out the controllers not applicable to your country.  

 

Assign Circuits and Universes to a controller: 

1. Expand the items under a DB 

2. Under circuits or universes, select a load type. This will filter the controller list to only show compatible 
controllers. 

3. Select a load type or a selection of circuits or universes. The controller list only displays compatible 
devices for your selection. 

4. Click and drag your selection onto a controller in the Controllers list. The controller and the assigned 
circuits or universes now appear in the Available Devices list.  

5. If a controller still has spare channels you can continue to drag additional circuits or universes until all 
controller channels are assigned. An assigned circuit or universe is marked with a green tick. 

6. If you are intending to use control modules, these must be placed into an empty slot inside a 
multipurpose (mixed) controller. Select a DB and double-click or click and drag a controller, from the 
mixed controller list up to the available devices list. You can then drag a module with an assigned circuit 
into an empty slot in the controller. 

7. Continue to assign remaining circuits and universes until they are all assigned to controllers. 

 

 

D If a universe straddles more than one area, then it must use DALI addressing. To assign these loads to a 
controller, click and drag the relevant  universe icon onto a DALI addressing controller. 

D Depending on the selected protocol, the following loads can be assigned to a signal controller output: 

• 1-10 V, DSI, DALI Broadcast loads can be assigned to a channel 

• DALI enumerated loads can be assigned to a universe. 
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Available Device icons: 

 Distribution Board  Unavailable universe or partial universe (galaxy) 

 DIN rail controller  Available universe or partial universe (galaxy) 

 Wall mounted controller  Incompatible channel for the selected load type 

 Empty DIN rail controller horizontal slot  Unavailable Channel 

 Populated DIN rail controller horizontal slot  Available Channel 

 Empty DIN rail controller vertical slot  Selected circuit or universe 

 Populated DIN rail controller vertical slot  Assigned circuit or universe 

 Empty Wall-mounted controller slot  Assignment Information note 

 Populated Wall-mounted controller slot  Assignment error 

 

E Double-click a controller to copy it to the Available Devices list. 

E Mouse over an information icon and error icon to display tooltips with more information. 

E Keep the Product Details window open to display information on the selected device. 
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15.2 Finalizing the Design 

The Hardware Selector menu provides the following options to finalize your quote. 

 Design  

 New 

 Open 

 Save 

       Save As… 

 Remove 

From the Design menu you can start a new design, open a design, save your design, 
save a different version of your design, and remove saved designs.  

Designs are only saved in the Job file, so to save your designs, you must also save the 
job file. 

 

 Reports  

Warnings and 
Disclaimers 
 

Distribution 
Board Totals 

Plan Totals 

Job totals 

 

You can export a list of the channel notes and disclaimers. 

 
 

The Reports menu allows you to select different bill of materials spreadsheets for the 
distribution board, the floor plan or for the entire job.  

Before exporting you will receive a warning notification if there are unresolved 
problems with the design. 

Apply to Job 

 

Creates the controllers and applies all the channel assignments to the job. 

 Delete 

 
Deletes a controller from the Available Devices list. 

 Rename 

 
Enables you to rename the selected circuit or universe. 

 Unassign 

 
Unassigns a circuit or universe from a controller. 

 Highlight Item 

 
Highlights the selected item or items under it on the floor plan. 

 Product Details 

 
Shows the selected product details in a separate window. 
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16 Generate reports 
You can use the following reports to help produce a Bill of Materials for the design: 

1. Circuit Summary Report – Provides the total number of each circuit type and DALI universes per 
distribution board and floor plan. 

2. Product Summary Report – Provides the total number of each device type in the project. 

3. Fixture Summary Report – Provides the total number of each fixture type in the project. 

4. Plan Summary Report – Provides the total number of devices and fixtures in the project per floor plan. 

 

17 Produce Documentation 
You can use the following documents for installation and commissioning: 

1. Single Line Report – Provides a single line diagram of all connected devices. Devices are grouped under 
network gateways. The order of devices is determined by the Device location sequence property. This 
can either be set manually under Device Properties or by drawing DyNet cable lines on the floor plan.  

2. Single Line with Circuits Report – The same as the Single Line report but also showing the circuit names 
for any load controllers 

3. Load Schedule Report – Provides a list of all load controllers, the name, output type and logical area of 
each of circuit under each load controller. 

4. Export Floor Plan to PDF – Allows the selected floor plan to be exported to PDF. The floor plan layers to 
be exported can be fully configured. 
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